Contents

1. Copyright Notice .................................................................................................................................................... 4

2. What is Gang Run Printing? ................................................................................................................................. 6
   2.1 Nesting .................................................................................................................................................................. 6
   2.2 Ganging ............................................................................................................................................................ 7
   2.3 Tiling ............................................................................................................................................................... 7
   2.4 Manual or Automated Gang Run Printing .................................................................................................... 8

3. Working with Gang Run Printing ........................................................................................................................... 9
   3.1 Preparing and Submitting your Graphics (Input Workflow) ......................................................................... 9
      3.1.1 Preparing your Graphics .......................................................................................................................... 10
      3.1.2 Tiling Oversize Graphics ......................................................................................................................... 11
      3.1.3 Submitting your Graphics ....................................................................................................................... 11
   3.2 Creating Nested Layouts on the Nesting Server .............................................................................................. 12
      3.2.1 Working with Substrate Queues .............................................................................................................. 13
      3.2.2 Substrate Sheet Sizes ............................................................................................................................. 14
      3.2.3 Keeping Track of your Stock .................................................................................................................. 15
   3.3 Getting Production Files out of your Nested Layouts (Output Workflow) ................................................... 15

4. The Gang Run Printing View .................................................................................................................................. 16
   4.1 Working with Substrates ................................................................................................................................. 16
      4.1.1 Adding a Substrate ................................................................................................................................. 17
      4.1.2 Editing a Substrate .................................................................................................................................. 22
      4.1.3 Duplicating a Substrate ........................................................................................................................ 22
      4.1.4 Deleting a Substrate ............................................................................................................................. 23
   4.2 Working with Graphics Submitted for Printing .............................................................................................. 23
      4.2.1 Graphics Overview .................................................................................................................................. 23
      4.2.2 Controlling the Printing Flow ................................................................................................................ 24

5. The Gang Run Printing Tasks .................................................................................................................................. 26
   5.1 Prepare Graphics for Nesting .......................................................................................................................... 26
      5.1.1 General Tab ............................................................................................................................................. 26
      5.1.2 Optimize Tab .......................................................................................................................................... 29
   5.2 Create Tiles ...................................................................................................................................................... 29
   5.3 Submit to Gang Run .......................................................................................................................................... 34
      5.3.1 General Tab ........................................................................................................................................... 35
      5.3.2 Back Tab ............................................................................................................................................... 37
      5.3.3 Substrate Tab ......................................................................................................................................... 38
      5.3.4 Extra Tab .............................................................................................................................................. 38
   5.4 Export Nested Layouts ...................................................................................................................................... 41
      5.4.1 Sheet Tab .............................................................................................................................................. 41
5.4.2 Production Files Tab......................................................................................................................... 45
5.4.3 Reports Tab......................................................................................................................................... 47
1. Copyright Notice

© Copyright 2014 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2014. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.
The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.
Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.
Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.
All other product names are trademarks or registered trademarks of their respective owners.
Correspondence regarding this publication should be forwarded to:
Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com
2. What is Gang Run Printing?

Gang Run Printing enables you to efficiently match graphic designs to be printed with the available substrate (to have as little substrate waste as possible and faster turnaround), with:

- **Nesting**,
- **Ganging**,
- **Tiling**.

This is especially useful when printing Sign and Display material and for shorter production runs. It takes into account the designs’ sizes, shapes and ordered quantities to produce layouts on substrate sheets.

2.1 Nesting

Nesting is laying out several graphic files in the most efficient way so that waste is minimized. When working with non-rectangular graphics, their bounding boxes may overlap in the layout.

For more information about nesting in Gang Run Printing, see *Creating Nested Layouts on the Nesting Server* on page 12.
2.2 Ganging

Ganging is combining several different graphic files, in one print job, even if those files belong to several orders (for example if one order doesn’t fill a whole substrate sheet).

This helps drive production costs down and helps you offer a competitive price to your customers.

2.3 Tiling

Tiling is splitting oversize graphics, used for example for billboards, into rectangular pieces (tiles) for printing. These tiles can then be glued together.
When printing the tiles, Gang Run Printing can nest them to get the most efficient layout.

2.4 Manual or Automated Gang Run Printing

- In i-cut Layout, you can perform manual Gang Run Printing: selecting and preparing each graphic individually, then finding layouts (the most efficient layouts are calculated automatically).
  When working manually in i-cut Layout, you can tweak the results if necessary. See the i-cut Layout manual for more information.

- In Automation Engine, you can automate the graphics selection and preparation too.
  You can also submit your graphics for nesting on your chosen substrate, and manage your substrate queues.
  When working automatically in Automation Engine, you can process more graphics in parallel, and you don’t need an operator to keep checking when to generate layouts (this is done automatically).
3. Working with Gang Run Printing

Here is an overview of how you can work with the Gang Run Printing module.

1. You first prepare your graphics and submit them to be nested on a particular substrate, in your chosen quantity.
   
   You do this through an input workflow, that should contain the Prepare Graphics for Nesting and the Submit to Gang Run tasks.
   
   See Preparing and Submitting your Graphics (Input Workflow) on page 9.

2. Once the graphics are submitted, they go in a substrate queue, and the nesting server calculates the best possible nested layouts, based on the sheet sizes and nesting parameters you defined.
   
   See Creating Nested Layouts on the Nesting Server on page 12.

3. Once the nesting server has found one or more optimal nested layouts, it delivers them to your output workflow, that creates production files (layout files and cut files).
   
   The output workflow must contain the Export Nested Layouts task. You can set this workflow to copy the production files to a specific folder and/or send the files to a press.
   
   See Getting Production Files out of your Nested Layouts (Output Workflow) on page 15.

3.1 Preparing and Submitting your Graphics (Input Workflow)
3.1.1 Preparing your Graphics

Before sending your graphics to be nested on the substrate of your choice, you need to make sure they have at least a cut path. You may also want to add bleed and SmartMarks.

You can use the Prepare Graphics for Nesting task to identify or extract a cut path from your graphic, and if necessary to add bleed and SmartMarks to it.

For more information about specific task parameters, please see Prepare Graphics for Nesting on page 26.

Identifying or Extracting a Cut Path

Your graphics must have a cut path as they will be nested based on their cut path.

For example, cardboard cut-outs of a tree (as below left) will be nested and cut differently than postcards of a tree (as below right).

Depending on the case, your tree graphic will need a different cut path (shown in red).
The cut path is typically provided in the file as a contour line in a spot color. For graphics that don't already contain a cut path, you can generate one from the white background, the trim box, or a separate file.

**Adding Bleed**

If your file doesn’t already have bleed outside the cut path or trim box, you can generate some in the Prepare Graphics for Nesting task.

**Adding SmartMarks**

SmartMarks are marks that automatically update based on changes to the sheet size, the number of inks on the sheet, etc. You can use them as regular marks or as production controls.

There are many types of SmartMarks (registration marks, barcodes, text, placeholders for eyelets...). You typically add SmartMarks to your nested layout in your output workflow (mostly for cutting the sheet), but in some cases you need to add some SmartMarks to your graphic in your input workflow.

For example:

- You can add eyelet marks to a graphic that will be used for a large eyeleted banner. You need to add the eyelet marks before tiling the graphic to fit the substrate.

- When defining the cut path in the input workflow, you can add text on this cut path for easy processing after cutting (for example to indicate the job and customer reference, or the order the tiles must be glued in...).

### 3.1.2 Tiling Oversize Graphics

In case the substrate size is smaller than the final printed object (for example when printing billboards), you can split the graphic into rectangular tiles (fitting the substrate size) that can later be glued together.

You can do this with the Create Tiles task. This task allows adding overlaps to be able to glue the tiles on top of each other.

### 3.1.3 Submitting your Graphics

Once your graphics are ready, you can send them for nesting using the Submit to Gang Run task.

The most important things to define in that task are:

- how many copies of that graphic you want,
- on which substrate (and optionally on which substrate size) you want it printed,
- if you have a specific due date to get that graphic printed.

**Note:**

Substrates are organized into substrate queues, which not only define the substrate to use but also how the graphics will be nested.

See Working with Substrate Queues on page 13 for more information.
3.2 Creating Nested Layouts on the Nesting Server

Automatic Calculation of Nested Layouts

Once your graphic(s) arrive in the substrate queue, the nesting server calculates possible layouts to nest those graphics, together with any graphic(s) already in the queue.

The nesting server tries to find the most optimal layout (or layouts, depending on your graphics) possible, taking into account these substrate queue settings:

- the nesting settings you set up,
- the different possible substrate sizes (if applicable),
- the minimum fill percentage for that substrate queue.

If the minimum fill is reached, the nesting server sends the layout(s) to the output workflow to generate production files. All graphics that have been nested in these layouts are then removed from the substrate queue.

If it isn’t reached, the graphics stay in the substrate queue until new graphics are submitted to the queue, at which point the nesting servers calculates possible layouts again.

Outputting a Partial Quantity of a Graphic’s Order

Sometimes the nesting server cannot fit all of the ordered copies of a graphic on layout(s) that satisfy the substrate queue settings.

In this case, rather than generating an extra layout that does not satisfy the minimum fill, the nesting server only outputs the quantity that does fit on the optimal layouts.

For example, if 10 copies of a graphic are ordered but only 8 fit on a layout satisfying the minimum fill, the nesting server does not generate a layout with only the remaining 2 copies. They will stay in the substrate queue.
Once new graphics are submitted to the queue, the nesting server will try to generate a nested layout containing the remaining 2 copies and the new graphics.

Generating Nested Layouts in Time for the Due Date
As your customers expect their printed goods to be delivered on a certain date, sometimes you cannot wait for the minimum fill to be reached. In this case, you can either:

- manually force a layout to be generated from the urgent graphics,
- enter a due date when submitting these graphics. The graphics will then be force-nested in time for that due date.

In both cases the nesting server generates a layout ignoring the minimum fill. However, it may also use other graphics from the queue in the layout to still raise the substrate's fill percentage.

3.2.1 Working with Substrate Queues
A substrate queue acts like a printer queue to which you can send jobs you want to nest and print on a particular substrate.

Substrate Queues Based on Material Types
For each type of substrate material you have in your stock, you should have a substrate queue. For example:
In your stock you have 2 piles of PVC substrates:
- Thickness 3 mm
- Thickness 5 mm
For this stock you should set up 2 substrate queues:
- PVC 3mm
- PVC 5mm

Substrate Queues Based on Nesting Settings
It can also be useful to define substrate queues based on how the graphics will be nested and printed.
- If you have an expensive substrate, you can set the nesting server to always nest the graphics so that the substrate waste is minimal.
- If your graphics need to be nested on a material that will be printed in offset, you could aim for less plates (so less layouts) at the cost of extra waste.

So if some graphics needs to be nested differently (even if it is on the same material), you might need to create a different substrate queue for each type of printing/processing.
For example:
In your stock you have a pile of 250 g/m cardboard both for business cards and door hanger orders. Business cards and door hangers will be cut differently:

- business card will be cut by a paper guillotine,
- door hangers will be cut on a cutting table.

The way graphics are cut influences the way they need to be nested. Since nesting settings are attached to a substrate queue, you need different substrate queues.

In this case you should set up 2 substrate queues:

- Cardboard for Business Cards
- Cardboard for Door Hangers

**Grouping Certain Graphics Together**

In certain cases, you don’t want to group certain graphics on the same nested layout, even when they are to be printed on the same substrate or using the same printer.

For example you do not want to mix graphics that need varnishing with normal graphics, or you do not want to mix graphics from different customers.

In this case you do not necessarily need to set up separate substrate queues for graphics to be nested separately, but you can use grouping keys when submitting the graphics.

Even when submitting them to the same substrate queue, the nesting server will only nest graphics that have the same grouping key together.

For example:
In your stock you have 1 pile of 220 gsm photo paper. Depending on the order, some graphics printed on this paper need to be laminated, some don’t.

In this case you only need to set up 1 substrate queue, for both regular and laminated graphics.

You can use a grouping key called “Lamination”, with the values “Yes” or “No”, to prevent laminated graphics being mixed with normal graphics.

### 3.2.2 Substrate Sheet Sizes

If you have a substrate material in several sheet sizes, you can add these sizes to the substrate queue for that material.

For example:
In your stock you have 3 piles of substrates:

- 1 pile of cardboard 2000x1000m
- 1 pile of cardboard 750x1200mm
- 1 pile of polystyrene 750x1200mm

For this stock you should set up 2 substrate queues:

- Cardboard (with 2 substrate sizes)
- Polystyrene (with 1 substrate size)
3.2.3 Keeping Track of your Stock

If desired, you can keep track of your stock of each different sheet size.

You indicate the quantity of sheets you have in that size, and every time the nesting server uses that sheet size for a nested layout, it will be subtracted from the available quantity.

Substrate Offcuts

The nesting server always tries to produce sheets with as little waste as possible. However, an approaching due date might force you to produce a sheet that has a significant portion of waste that could actually be re-used.

You can bring those rectangular leftovers (also called offcuts) back into circulation, by adding them to the substrate queue as a smaller sheet size, together with their quantity.

3.3 Getting Production Files out of your Nested Layouts (Output Workflow)

Every substrate queue is linked to an output workflow. You can build this workflow to your own needs, but it should at least contain the Export Nested Layouts task.

As soon as the nesting server has found one or more optimal nested layouts for your substrate queue, it delivers them to its output workflow, which is started automatically.

The output workflow then generates production files:

- A PDF file for the press, containing the nested layout, and marks for printing and cutting, but no technical inks.
- A CUT file for the cutting table, containing the combined cut path of the nested graphics.
- (Optionally) a nesting report, in PDF format (which can be used as guide by the cutting table operator) and/or in XML format (which can be used by the MIS for invoicing).
4. The Gang Run Printing View

The **Gang Run Printing** view in the Pilot shows an overview of all graphics that have been submitted for nesting on each of the available substrates.

![Image of Gang Run Printing view]

1. Substrates available
2. Graphics submitted for nesting on the selected substrate
3. Details of the selected graphic

From this view, you can:

- define substrates and their characteristics,
- have an overview of all graphics submitted to each substrate queue, and their state,
- control the printing flow (for example you can put some graphics on hold, or force-print some of them).

### 4.1 Working with Substrates

When **submitting graphics** to be nested on a substrate, the graphics arrive in the corresponding **substrate queue** in the **Gang Run Printing** view.

In the **Substrates** list, you can see at a glance how many graphics have been submitted for nesting on a particular substrate.

The nesting server then calculates the best possible nested layout(s) for these graphics, based on:
• the graphics quantity ordered,
• the sheet sizes and nesting parameters you defined for your substrate queue.

The substrate queue icon becomes animated during this calculation.

We strongly recommend you define your substrates queues here before submitting graphics to them.

**Note:**

If you submit graphics to a substrate queue that is not defined in the Substrates list (by entering an unknown substrate in the Submit to Gang Run task), this substrate queue will be created automatically in the Substrates list, but will miss crucial parameters (such as sheet sizes and a link to an output workflow), so the nesting server won’t be able to calculate layouts for it.

You will see a warning sign on the substrate icon to indicate that the substrate queue isn’t properly configured. In this case, make sure to add the missing parameters.

You can also manage your substrates (edit, duplicate or delete them) from the Gang Run Printing view.

### 4.1.1 Adding a Substrate

1. Click the action button 🕳️ at the bottom of the Substrates list and select New Substrate...
   
   You can also go to File > New Substrate... or press Ctrl + N on Windows / Cmd + N on Mac.

2. In the New Substrate dialog, enter the substrate Name.

3. In the Sheet Sizes tab, specify the sheet size(s) your substrate comes in.
   
   **Attention:** You need to define at least one sheet size for the substrate, otherwise graphics sent to this substrate’s queue will not be nested and printed.

4. In the Nesting tab, set the nesting settings for your substrate.
   
   Graphics submitted for Gang Run Printing on this substrate will be nested according to these settings.

5. In the Workflow tab, select the output workflow to launch on the graphics submitted to that substrate’s queue.
   
   **Attention:** You must link an output workflow to your substrate, otherwise you won’t get production files for the graphics you submitted to that substrate queue!

6. Click OK to save your substrate.

**Note:**

If you save your substrate without having defined all the necessary settings (for example if you haven’t linked a workflow to your substrate), you will get a warning message, and there will be a warning sign on the substrate icon ⚠️. If this is the case, you need to edit your substrate to define the missing settings. When you are done, you should have a regular substrate icon 🆙.
Defining Sheet Sizes

For every sheet size you want to add:

1. Click Add (on Windows) or + (on Mac).
2. In the Add Sheet Size dialog, enter a Name for the sheet size you are adding.
3. In the Size parameters, enter the sheet’s width and height.
   
   The units used are those you defined in the Pilot Preferences (in Edit > Preferences > Units on Windows or Automation Engine > Preferences > Units on Mac).

4. Enter the Margins to use.
   
   The margins won’t contain nested graphics, but can contain marks.

5. If desired, you can keep track of the Stock you have of that sheet size.
   
   To do this, select Use available quantity of and enter the number of sheets you have in that size.
   
   Every time the nesting server uses that sheet size for a nested layout, it will be subtracted from the available quantity.

   **Attention:**
   
   If you are keeping track of the stock here and the stock reaches 0, the nesting server will not nest layouts on that sheet size anymore.
   
   This can cause graphics to be stuck in the substrate queue (if this was the only sheet size defined for that substrate, or you chose to nest the graphics on that sheet size specifically).
   
   When you get more sheets in that size, you should edit the available quantity.

6. Click OK.

Defining Nesting Settings

1. Select the Nesting Type to use for the layout:

   - **Minimal Waste** tries to reduce the waste in material to a minimum in the layouts generated.
   - **Minimum Layouts** aims to generate as few layouts as possible, potentially at the cost of having some more waste.
     
     Having fewer layouts can reduce setup time, making this option interesting for offset printing.
   - **Guillotine Cut** generates layouts that can be cut on a Guillotine cutting table (which can only cut in straight edge-to-edge movements).
     
     This usually reduces the number of cuts per layout but may increase the number of layouts and the waste.
     
     In the example below, the layout at left cannot be cut on a Guillotine table. A Guillotine nesting can generate for example the layout at right, which can be guillotine-cut. The graphics that don’t fit on that layout will be placed on another layout.
2. Select the **Search Method** to use for calculating the layout.

   Depending on if you are running a test or processing graphics for production, you can set the layout search from **Very Fast** to **Slow (Very Accurate)** (the faster the search, the less accurate the result can be).

3. If you want to nest the graphics in the order in which they are coming in, select **Respect the graphics order**.

4. Depending on the **Nesting Type** you selected, you can set extra options:

   **| If you have selected... | you can set: |
   ---|---|---|
   Minimal Waste or Minimum Layouts | • the **Fill Starting Point on Sheet** (where the first graphic will be placed): at the Top Left, Top Right, Bottom Left or Bottom Right,  
   | • the **Primary Fill Direction** (in which direction the sheet will be filled): Horizontal or Vertical. |
   Guillotine Cut | the direction of the **First Cut**: Horizontal, Vertical or Don’t care. |

5. If desired, you can add a **Gutter** in between cut paths (specify the gutter width).

6. If the graphics in your files have a bleed outside the cut path, you can clip it away by entering the bleed distance into **Bleed Clipping Mask**.

7. When working with **Guillotine Cut**, you can choose to allow the nesting server to print a few extra copies of some of the graphics, so that you have more printed sheets with the same layout.

   This reduces the amount of plates needed for offset printing, keeping the costs down.

   • If you want to do this, set a **Maximum Overrun**.
     
     For example set a **Maximum Overrun** of 10.0% if you don’t mind printing up to 10% more of some of the graphics to have less layouts.

   • If you want to only print the exact ordered quantity of each graphic, and don’t mind the number of layouts, keep the **Maximum Overrun** at 0.0%.

   For example, you need to print 100 “BLUE” graphics and 10 “RED” graphics, on a sheet size that can fit 10 graphics.

   • If you don’t allow overrun, you will have 2 layouts:
• A layout with 9 "BLUE" and 1 "RED" graphics, to be printed 10 times (giving 90 "BLUE" and 10 "RED" graphics).

• A layout with 10 "BLUE" graphics, to be printed 1 time (for the remaining "BLUE" graphics).
• If you allow a **Maximum Overrun** of 20.0%, you will have only 1 layout, with 9 "BLUE" and 1 "RED" graphics, to be printed 12 times.
This gives 108 "BLUE" graphics (8% more than ordered) and 12 "RED" graphics (20% more than ordered).

8. In **Rotation**, specify if the task can rotate the graphics in the layout to get a better fit. You can choose:
   - Allow any angle,
   - Allow 90 degree,
   - Allow 180 degree,
   - No rotation.

9. Enter a **Minimum Fill** if you only want to output the sheet when it’s filled to a certain level.
   
   **Attention:**
   Do not put 100% here as only the graphics inside the cut path count as fill. The margins, gutters etc. all count as waste.
   By default, the minimum fill is set to 75%.

**Linking a Workflow to Your Substrate**

1. Select the output **Workflow** to launch on the graphics submitted to that substrate’s queue.

   This **output workflow** will be launched either:
   - when the **minimum fill percentage** for that substrate is reached,
• in time for the submitted graphics’s due date (if they have one),
• when you force print one or more graphics from the substrate queue.

⚠️ Attention: You must link an output workflow to your substrate, otherwise you won’t get production files for the graphics you submitted to that substrate queue!

2. If you have set a due date for the graphics to be printed, you can choose to Launch the workflow automatically a certain number of hours and/or minutes before the due date.

If the workflow hasn’t been launched by then (because the minimum fill percentage for that substrate hasn’t been reached), it will be automatically launched at that time (even if the fill percentage isn’t reached).

4.1.2 Editing a Substrate

1. Select the substrate that you want to edit, click the action button 🔄 and select Open.

Tip: You can also go to File > Open or press Ctrl + O on Windows / Cmd + O on Mac, or just double-click the substrate to edit.

2. In the Edit Substrate dialog, you cannot change the substrate Name, but you can edit all the other settings.

Note: If you want to change the substrate name, we recommend you duplicate the substrate under your chosen name, then delete the original substrate.

3. In the Sheet Sizes tab, you can add, modify or delete sheet sizes for the selected substrate.

• to add a sheet size, click Add (on Windows) or + (on Mac) and define the sheet size settings.
• to modify a sheet size, select it, click Edit (on Windows) or 📋 (on Mac), and change the settings as desired.
• to delete a sheet size, select it and click Remove (on Windows) or - (on Mac).

4. In the Nesting tab, you can edit the nesting settings for the substrate.

5. In the Workflow tab, you can link a different workflow to the substrate or change when to launch it automatically.

6. Click OK to save your changes or Cancel to revert.

Note: After changing the substrate settings, the nesting server will automatically re-calculate nesting layouts for the graphics in that substrate queue, even if no new graphic was submitted.

4.1.3 Duplicating a Substrate

1. Select the substrate that you want to duplicate, click the action button 🔄 and select Duplicate....

Tip: You can also go to File > Duplicate... or press Ctrl + D on Windows / Cmd + D on Mac.
2. In the **Duplicate Substrate** dialog, enter a **Name** for the new substrate.

3. The substrate settings are the same as the old substrate's, but you can modify them if necessary.
   
   See:
   
   - *Defining Sheet Sizes* on page 18
   - *Defining Nesting Settings* on page 18,

4. Click **OK** to save your new substrate.

### 4.1.4 Deleting a Substrate

1. Select the substrate that you want to delete, click the action button 🚫 ▼ and select **Delete**.

   **Tip:** You can also go to **File > Delete** or press the **delete** key.

2. In the dialog that pops up, click **Delete** to confirm that you want to delete that substrate.

### 4.2 Working with Graphics Submitted for Printing

#### 4.2.1 Graphics Overview

**List of Graphics per Substrate**

If there are graphics submitted for nesting on a substrate, you will see the number of graphics to be nested next to that substrate queue. ![Polystyrene](image)

Click the substrate to see the list of graphics and their printing information at right.

**Printing Information**

For each graphic, you will see:

- the **File Name** and the page to be printed in that file,
- the **Sheet Size** it should be printed on (if this was defined when submitting the graphic),
- the **Quantity** ordered,
- the **Remaining Quantity** to be printed (if some copies of the graphic have already been included in a nested layout this is what remains in the queue),
- the **State** of the graphic in the substrate queue,
- the date it was submitted (**Submit Date**),
- the **Due Date**.

This information comes from the settings defined when submitting the graphic to the queue.

If you want to find a specific graphic in the list, you can filter the graphics' list using the search field ![Search](image), or sort the graphics by any of the columns by clicking the column header. The sorting order has no influence on the output.
Tip:
You can also show / hide or reorganise columns by going to View > Select columns in ‘Gang Run Printing’...

For example, you can show columns with your labels and grouping keys and use that to sort graphics.
Your column settings are saved when you quit the Pilot and restored the next time you log in.

### Graphics States

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
</table>
| ➡ | Graphics ready to be nested and output.  
When the nesting server calculates possible layouts, it will try to include all of the graphics with this state in the most efficient layout(s) possible. |
| ⏹️ | Graphics on hold.  
Graphics with this state will not be included in the layout calculations. |
| ✗ | Graphics that couldn't be placed on a layout because they are too big. It could be that:  
- The graphic is too big for any available sheet size of that substrate. In this case, consider either defining a bigger sheet size (if you have some available), or choosing a different substrate when submitting the graphic to the queue.  
- The graphic is too big for the sheet size you chose to nest it on (when submitting it to the queue). In this case, choose a bigger sheet size, or set the graphic to be nested on Any sheet size of your substrate when submitting it to the queue.  
- It's too big to fit within the rotation possibilities defined for that substrate queue. In this case, change the rotation parameter to Allow any angle. |

If none of these solutions help, you need to tile your graphic before submitting it to the substrate queue.

### 4.2.2 Controlling the Printing Flow

By default, graphics will be sent to the output workflow automatically either when the desired fill is reached or at the time you set (a certain amount of time before the due date).

However, you can:

- Put graphics on hold: select the graphic(s) and click the Hold button 🟢. Graphics on hold have a hold icon ⏹️ next to them in the table.

**Note:** You can put one or more graphics (or even all graphics in the queue) on hold, but you cannot put the queue itself on hold: even if all of the queue's graphics are on hold, new graphics submitted to the queue will still trigger a layout calculation.

- Release graphics that are on hold: select the graphic(s) and click the Release button 🔄. Graphics that are not on hold have a ready icon ➡.

- Force-print graphics: select the graphic(s) and click the Print Now button 🚀.
Note:

To get a better substrate usage, some other graphics may be printed along the graphic(s) you force-print. In this case, you will see that either these graphics disappear from the list, or their Remaining Quantity is reduced.

Graphics that are on hold will not be included. If you want to force-print a graphic on hold, you need to release it first.

- Remove a graphic from the queue: select the graphic and click the Delete button.

Note: This will not delete the graphic file itself, only remove it from the substrate queue.
5. The Gang Run Printing Tasks

5.1 Prepare Graphics for Nesting

Use this task to prepare individual graphics for Gang Run Printing (you can add a cut path, bleed, and SmartMarks in the General tab, and optimize your cut path in the Optimize tab).

You can send the following graphic file formats to this task:

- TIFF (CMYK or grayscale),
- JPEG (CMYK or grayscale, progressive JPEG compression is not supported),
- PSD (CMYK or grayscale),
- PDF (single page or multipage),
- Normalized PDF (single page or multipage).

Typically, you use this task before a Submit to Gang Run task in an input workflow. The input workflow prepares the graphics and submits them to a substrate queue on the nesting server (see Working with Gang Run Printing on page 9 for an overview of the whole Gang Run Printing process).

5.1.1 General Tab

1. In Create Cut Path, define what to use as a cut path, or how to generate one.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>do the following...</th>
</tr>
</thead>
</table>
| use an ink as cut path | 1. Select From Ink or Trim Box.  
2. Enter the name of the ink to use in the field below.  

Tip:

- If the ink used for the cut path has different names in different input files (for example if you have customers from different countries using names like cut, découpe, taglio...), you can add several ink names, separated by a comma (, ).  
  The order you use is important as the task will use the first ink it finds in the list as cut path!

- You can use wildcards and/or use SmartNames to define ink names. For example use Pantone* if you want to use any Pantone ink used in the file as a cut path.
<table>
<thead>
<tr>
<th>If you want to...</th>
<th>do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tip:</strong></td>
<td>When building a workflow using an example file, click to select one or more of the inks from the example file. If you always receive CMYK graphics with one spot color used for the cut path, select Any SpotColor.</td>
</tr>
<tr>
<td>3. Define what to do if the ink(s) you defined are not present in the file:</td>
<td></td>
</tr>
<tr>
<td>• If you want to use the trim box as cut path instead, select Create cut path from trim box if no ink is found.</td>
<td></td>
</tr>
<tr>
<td>• If you don't want to use the trim box but want the task to end in error, leave Create cut path from trim box if no ink is found deselected.</td>
<td></td>
</tr>
<tr>
<td>use the trim box as cut path</td>
<td>Select From Ink or Trim Box (without specifying an ink to search for). If you always want to use the trim box as cut path (usually for rectangular graphics like business cards), you don't need to select Create cut path from trim box if no ink is found (as this option is only applicable when you want an ink as cut path as your first choice).</td>
</tr>
<tr>
<td>use the cut path defined in an external ARD, PDF or Normalized PDF file</td>
<td>Select From File and Browse to that file (or use SmartNames to define the path to the file).</td>
</tr>
<tr>
<td>create a cut path from the contour of the graphic on its white background</td>
<td>Select From White Background. <strong>Note:</strong> When creating a cut path this way, we recommend you select the Flatten Objects option. This will include both the contour of the design on the white background and the contours of any &quot;white holes&quot; in the design in the cut path. You can then remove the &quot;white holes&quot; contours using the Remove holes option.</td>
</tr>
</tbody>
</table>

2. In **Cut Path's Ink Name**, enter the ink name to use for the cut path you just defined.

- If you defined the cut path based on an ink in your file, this will rename that ink to the name you enter here.

**Tip:** Use this to standardize cut path ink names across files (especially when your files come from different customers).
• If you defined the cut path from the file’s trim box, white background, or an external file, this will add the cut path in that ink in your graphic file.

The cut path ink name you enter here will be used to identify the cut path in the Submit to Gang Run task later in the input workflow.

3. If the graphic contains no bleed, you can add some here.

Select Create Bleed and enter the bleed distance (the distance outside the cut path). You can also use a SmartName.

You can choose between two Bleed Modes:

• Choose Clone to take the part of the graphic just inside the cut path and replicate it to the outside of the cut path.

![Clone example]

This is typically the best option for non rectangular cut path shapes.

• Choose Mirror to take a part of the graphic just inside the cut path (as much as the bleed distance) and mirror it to the outside of the cut path.

![Mirror example]

This is typically the best option for rectangular cut path shapes.

4. If desired, you can add SmartMarks (a SmartMarks set that you created in i-cut Layout or PackEdge) to the resulting graphics.

For example, you can add marks around the cut path to indicate the customer and the job name. These will be visible in the bleed on the cutting table and can help organize your printed graphics after cutting.

You can use SmartNames to enter your SmartMarks set’s name.
Note:
Before you can do this, you need to:

1. Make sure your icut Layout or PackEdge application is connected to your Automation Engine server.
2. Create and save a SmartMarks set in icut Layout or PackEdge (this automatically saves it to the correct location on your Automation Engine server: \\Aservername\bg_data_marks_v010\dat).

See the icut Layout or PackEdge manual for more information about connecting to an Automation Engine server and creating a SmartMarks set.

### 5.1.2 Optimize Tab

If you created the cut path with the *From White Background* method, you typically need to optimize the cut path contours that were automatically generated, to facilitate and speed up the cutting process.

You can:

- **Remove holes** in your cut path.
  
  Select this if the cut path was extracted from a white background and your graphic contains white. This option makes sure that the white parts in your graphic are not considered part of the background (which would create holes in your graphic).

- **Smooth small jagged edges in your cut path**.

  Select **Smooth cut path with minimum distance between path points** and enter the desired distance. Any point that deviates from the cut path by less than that distance will be smoothed.

- **Remove small objects from your cut path**.

  Select **Remove contours smaller than** and enter the minimum size for your graphic’s small objects. Any objects smaller than this will be removed from the cut path.

- **Move the cut path inwards or outwards**.

  Select **Offset cut path** and enter a positive offset value (to move it outwards) or a negative one (to move it inwards).

You can use SmartNames to specify any of these values.

### 5.2 Create Tiles

Use this task to tile oversize graphics, used for example for billboards, into smaller graphics to be printed. You can select the size/number of the tiles, and allow for an overlap if necessary.

You can send the following graphic file formats to this task:

- **TIFF** (CMYK or grayscale),
- **JPEG** (CMYK or grayscale, progressive JPEG compression is not supported),
- **PSD** (CMYK or grayscale),
• PDF (single page or multipage),
• Normalized PDF (single page or multipage).

Note:
• For each image file or single page PDF, the task outputs a multipage PDF in which each page contains a tile.
• For multipage PDFs, the task outputs a multipage PDF (in which each page contains a tile) for each page of the input multipage PDF.

1. In **Method**, choose how to determine the number and size of the tiles:

   • If the tile size is the most important (if for example you can only print a certain size), choose **Use Fixed Tile Size** and enter the horizontal and vertical Tile Size.

     **Note:** The last tiles might be smaller (depending on the tile size and the size of the original file).

     Select **Allow Rotation** if you don't mind having the graphic rotated by 90 degrees in case this fits better and generates less tiles.

   • If the number of tiles is more important to you than their size, choose **Use Grid** and enter the **Number of Tiles** you want horizontally and vertically.

   • If you don't know the exact number or size of the tiles you want, but you can only print up to a certain size, choose **Automatic Tiling** and enter the **Maximum Tile Size** horizontally and vertically.

     The number and size of the tiles are calculated to have the least waste and the least tiles possible, within that maximum size.

     All tiles will have the same size, except when **adding an overlap**.

     Select **Allow Rotation** if you don't mind having the graphic rotated by 90 degrees in case this fits better and generates less tiles.

   • If you have a tiling template that you have created in icut Layout and want to use here, choose **Use Template** and select your template in the **Template** list.

     **Note:** To do this, you need to:

     1. Make sure your icut Layout application is connected to your Automation Engine server.
     2. Create and save the template in icut Layout (this automatically saves it to the correct location on your Automation Engine server: `\AEservername\bg_data_custom_v010\dat\tiling`).

     See the icut Layout manual for more information about connecting to an Automation Engine server and creating a tiling template.

     With a tiling template:

     • you can see exactly how your graphic will be tiled when creating the template in icut Layout (if you create the template from the same/a similar graphic that you will use in Automation Engine),
• you make sure you have consistent tiling in icut Layout and Automation Engine (for example if you use icut Layout for some graphics orders and Automation Engine for others).

**Attention:** If you want to add overlaps to your tiles when using a template, you need to already add them in the template in icut Layout. You cannot add overlaps to tiles created from a template in the *Create Tiles* task.

If you enable *Fit graphics to grid*, your graphic will be scaled to match the grid size, both vertically and horizontally. This can result in non-proportional scaling!

2. Define what to use as *Cut Path*.

**Note:** Whereas the *Prepare Graphics for Nesting* task allows you to generate a cut path if the graphic doesn’t contain one, in the *Create Tiles* task the cut path needs to be already available, either as an ink or by using the trim box as cut path.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>use an ink as cut path</td>
<td>1. Enter it in the Cut Path field.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong></td>
</tr>
<tr>
<td></td>
<td>• If the ink used for the cut path has different names in different input files (for example if you have customers from different countries using names like <em>cut</em>, <em>découpe</em>, <em>taglio</em>...), you can add several ink names, separated by a comma (, ). The order you use is important as the task will use the first ink it finds in the list as cut path!</td>
</tr>
<tr>
<td></td>
<td>• You can use wildcards and/or use SmartNames to define ink names. For example use <em>Pantone</em> if you want to use any Pantone ink used in the file as a cut path.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong></td>
</tr>
<tr>
<td></td>
<td>When building a workflow using an example file, click <img src="image" alt="Tip" /> to select one or more of the inks from the example file. If you always receive CMYK graphics with one spot color used for the cut path, select <em>Any SpotColor</em>.</td>
</tr>
<tr>
<td></td>
<td>2. Define what to do if the ink(s) you defined are not present in the file:</td>
</tr>
<tr>
<td></td>
<td>• If you want to use the trim box as cut path instead, select <em>Create cut path from trim box if no ink is found</em>.</td>
</tr>
<tr>
<td></td>
<td>• If you don’t want to use the trim box but want the task to end in error, leave <em>Create cut path from trim box if no ink is found</em> deselected.</td>
</tr>
<tr>
<td>If you want to...</td>
<td>do the following...</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>use the trim box as cut path</td>
<td>Leave the Cut Path field empty. If you always want to use the trim box as cut path (usually for rectangular graphics like business cards), you don’t need to select <strong>Create cut path from trim box if no ink is found</strong> (as this option is only applicable when you want an ink as cut path as your first choice).</td>
</tr>
</tbody>
</table>

The task will tile the graphic that is inside the cut path. The tiles created will have a cut path in the same ink as the input graphic’s cut path (if the cut path is created from the trim box, this will be the cut ink).

3. Typically, graphics for large banners or billboards are not supplied in the size at which they will be printed out. In this case, you can **Scale** them up here. For example, enter 1000% if your graphic is only 10% of the size you will need it to be.

4. If the graphics in your files have a bleed outside the cut path, you can clip it away by entering the bleed distance into **Bleed Clipping Mask**.

5. If desired, you can add **SmartMarks** (a SmartMarks set that you created in i-cut Layout or PackEdge) to the tiles. For example, you can add SmartMarks containing glueing instructions in the overlap zones. You can use SmartNames to enter your SmartMarks set’s name.

**Note:**

Before you can do this, you need to:

1. Make sure your i-cut Layout or PackEdge application is connected to your Automation Engine server.
2. Create and save a SmartMarks set in i-cut Layout or PackEdge (this automatically saves it to the correct location on your Automation Engine server: `\AEservername\bg_data_marks_v010\dat`).

See the i-cut Layout or PackEdge manual for more information about connecting to an Automation Engine server and creating a SmartMarks set.

**Tip:** We recommend you define your SmartMarks set in i-cut Layout, as it contains tiling-specific SmartMarks fields (for adding tile numbers).

6. If you want to include overlaps (for example if the tiles’ edges are to be glued on top of each other), select **Add Overlap** and click the **Options...** button to set how exactly where and how big the overlaps should be.

In the **Overlap Options** dialog:

a) Enter the **Overlap** distance.

b) In **Tile Start Position**, select where you want the first overlap to be: on the top left, top right, bottom left or bottom right tile.
Note:
You can use SmartNames for most options of this dialog. For button options like Tile Start Position, Direction and Pattern, you can set a SmartName by clicking $\text{Edit...}$, and edit it by clicking Edit...

Tip:
To know what the SmartName should resolve to to get a certain value for a parameter, do the following:

1. Right-click the parameter value and select Copy Parameter Value.
   - For a parameter with a field to edit (like Overlap), enter the desired value in the field then right-click in that field.
   - For a parameter with buttons (like Tile Start Position), right-click the button of your choice.
2. Paste this in a text editor.
   For example, the SmartName to get a top left Tile Start Position should resolve to $\text{tl}$.

c) In Direction, select whether the overlaps should run horizontally $\rightarrow$ or vertically $\downarrow$.

Depending on the Tile Start Position you chose, horizontal overlaps can run from left to right $\rightarrow$ or from right to left $\leftarrow$, and vertical overlaps can run from top to bottom $\downarrow$ or from bottom to top $\uparrow$.

d) In Pattern, choose whether you want the overlaps to run snake-wise $\rightarrow\uparrow$ or zig-zag $\rightarrow\downarrow$.

The exact snake-wise or zig-zag pattern depends on what Tile Start Position and Direction you selected.

For example, when starting on the top left tile $\text{tl}$ and running horizontally $\rightarrow$ with a snake-wise pattern $\rightarrow\uparrow$, you will get something like this:
We recommend you run a test to determine exactly what pattern works best for your graphic.

e) You can choose to add an **Overlap on both sides** of each tile (using the overlap distance you set on both sides).

In this case, you cannot add a glue area to your overlaps.

f) If desired, add a **Glue Area** to your overlaps.

This area will not be printed and you can add glue to it after cutting the tiles.

g) Click **OK**.

---

**Attention:** Adding overlaps increases the tiles size (of all tiles except the last ones). If you selected the **Use Fixed Tile Size** or **Automatic Tiling Method**, you should take the overlap distance into account.

7. If you want a report detailing how the graphic was tiled, select **Create tiling report** and click the **Options...** button to choose how the report will look like.

   a) In **Report Size**, select if you want your report on an **A4** or a **Letter** page.

   b) In **Units**, choose if you want the report to use **mm** or **inch**.

   c) Click **OK**.

---

### 5.3 Submit to Gang Run

Use this task to **submit** a graphic file to a **substrate queue**, where it will be nested with other graphics to optimize substrate usage.

In this task, you can specify parameters (quantity, scale factor...) for nesting graphics based on their cut path.

You can send the following graphic file formats to this task:

- TIFF (CMYK or grayscale),
- JPEG (CMYK or grayscale, progressive JPEG compression is not supported),
- PSD (CMYK or grayscale),
- PDF (single page or multipage),
- Normalized PDF (single page or multipage).
5.3.1 General Tab

1. Define how many of each input graphic you want to print.
   You can either:
   - Enter the **Quantity** to print.
   - Select **Maximum Fill** if you want to print as many copies as will fit in one sheet.

2. Typically, graphics for large banners or billboards are not supplied in the size at which they will be printed out. In this case, you can **Scale** them up here.
   For example, enter 1000% if your graphic is only 10% of the size you will need it to be.

3. Define what to use as **Cut Path**.

**Note:** Whereas the *Prepare Graphics for Nesting* task allows you to generate a cut path if the graphic doesn’t contain one, in the *Submit to Gang Run* task the cut path needs to be already available, either as an ink or by using the trim box as cut path.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>do the following...</th>
</tr>
</thead>
</table>
| use an ink as cut path | 1. Enter it in the **Cut Path** field.  
**Tip:**  
- If the ink used for the cut path has different names in different input files (for example if you have customers from different countries using names like cut, découpe, taglio...), you can add several ink names, separated by a comma (,).  
  The order you use is important as the task will use the first ink it finds in the list as cut path!  
- You can use wildcards and/or use SmartNames to define ink names. For example use Pantone* if you want to use any Pantone ink used in the file as a cut path. |
<table>
<thead>
<tr>
<th>If you want to...</th>
<th>do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tip:</strong></td>
<td>When building a workflow using an example file, click <img src="image" alt="example file" /> to select one or more of the inks from the example file. If you always receive CMYK graphics with one spot color used for the cut path, select <strong>Any SpotColor</strong>.</td>
</tr>
</tbody>
</table>

2. **Define what to do if the ink(s) you defined are not present in the file:**
   - If you want to use the trim box as cut path instead, select **Create cut path from trim box if no ink is found**.
   - If you don’t want to use the trim box but want the task to end in error, leave **Create cut path from trim box if no ink is found** deselected.

| use the trim box as cut path | Leave the **Cut Path** field empty. If you always want to use the trim box as cut path (usually for rectangular graphics like business cards), you don’t need to select **Create cut path from trim box if no ink is found** (as this option is only applicable when you want an ink as cut path as your first choice). |

4. **If you want to set a due date (when the sheet with the nested graphics needs to be printed), select **Due Date** and choose when you want the due date (and the due time) to be:**
   - If you set a due date, the nesting server will always generate a nested layout that includes this graphic before your due date, even when the minimum fill has not been reached.

**Tip:** In your substrate queue settings, you can choose to generate the nested layout and send it to the output workflow *a specific time before the due date*. This allows time for printing, production...

- If you don’t set a due date, the nesting server will only generate a nested layout when the minimum fill is reached.

<table>
<thead>
<tr>
<th>Select...</th>
<th>to...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Immediate</strong></td>
<td>generate a nested layout including your graphic immediately (this is the same as when you use <strong>Print Now</strong> in the <strong>Gang Run Printing</strong> view).</td>
</tr>
<tr>
<td><strong>Today</strong></td>
<td>set the due time to a certain time today (this is the default option). The nesting server will generate a nested layout including your graphic <em>the specified amount of time</em> before the due time.</td>
</tr>
<tr>
<td><strong>Tomorrow</strong></td>
<td>set the due date to a certain time tomorrow.</td>
</tr>
</tbody>
</table>
The nesting server will generate a nested layout including your graphic the specified amount of time before the due time.

<table>
<thead>
<tr>
<th>Select... to...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In ... hours</td>
<td>set the due time a certain number of hours after the task is launched (you can set this with a SmartName).</td>
</tr>
<tr>
<td>In ... days</td>
<td>set the due date a certain number of days after the task is launched (you can set this with a SmartName). You also need to set the due time.</td>
</tr>
<tr>
<td>On</td>
<td>set the due date to a specified date (and time) in the future.</td>
</tr>
<tr>
<td>Job due date</td>
<td>set the due date to the due date specified in the job setup.</td>
</tr>
<tr>
<td>Select SmartName...</td>
<td>set the due date using a SmartName. This opens the SmartNames dialog where you can select your SmartName.</td>
</tr>
</tbody>
</table>

Note:
- See SmartNames in the general Automation Engine manual for information about SmartNames and how to create custom ones.
- Your SmartNames must resolve to a value in the ISO 8601 standard format (for example 2014-09-27T11:08:00+02:00).
- If your due dates are supplied in a different format (for example 27/09/14), use the formatting options for date and time SmartNames to convert this format to the ISO standard.

5.3.2 Back Tab
- On the Back tab, you can specify what to print on the back of each graphic:
  - **No graphics**: choose this if you don't want any back side for the graphic.
  - **Even pages of multipage file**: choose this to print the odd pages of the file on the front, and the even pages on the back (this only works with multipage PDFs).
  - **Graphics from front side**: choose this to print the same graphic on the front and on the back. If your graphic has an irregular shape, you can select **Flip horizontally** so both graphics face the same direction and have the exact same contour for cutting.

  Note: If your graphic contains text, you shouldn't flip it as this will make the text unreadable.

  - **Other graphics**: choose this to print different graphics on the back, and **Browse** to these graphics.
Tip: Give the graphics to print on the back a consistent name, and use SmartNames to retrieve them (for example, [File]_back.[Extension of File]).

5.3.3 Substrate Tab

1. Choose the **Substrate** to print your graphics on.

   **Attention:**
   You should choose (one of) the substrate(s) you have defined as a **substrate queue** in the **Gang Run Printing** view.

   If you submit your graphics to a non existent substrate, a substrate queue will be created automatically for this substrate, but it won’t be ready to process your graphics (so your graphics will be stuck in the queue until you **configure it** properly).

2. If this substrate has several sizes defined, you can choose which **Substrate Size** to use.
   Or leave this on **Any** to let Automation Engine find the best fit.

5.3.4 Extra Tab

In this tab you can enter:

1. A **Customer ID** identifying the customer who ordered the graphics.
2. Your desired values for the custom fields you defined in the **Configure** tool.

You can use both customer ID and custom fields either as:

- labels in the **reports** about the nested layouts or the graphics,
- grouping keys to define **which graphics can be nested together**.

**Example 1: Using Custom Fields as Labels**

You get graphics orders from national and international customers. You are using different shipping companies for national and international orders.

When generating layouts, you want to indicate which graphics are for national and for international shipping, so the cutting operator can store the finished graphics in the right places.

1. In the **Configure tool**, define a **Custom Field** as **Shipping**.

   The corresponding **Custom Field** parameter in this task tab will now be called **Shipping** instead.

2. When launching the task on graphics from international orders, enter **International** in that parameter, otherwise enter **National**.

3. In your **output workflow**, choose to generate a **layout PDF report** in the **Export Nested Layouts tab**.

4. In the layout report, you will see for each graphic name:

   - the label **National** if the copies of this graphic need to be shipped nationally,
   - the label **International** if the copies of this graphic need to be shipped internationally.
5. If you open the report in an application that can show PDF layers (for example Adobe Reader), you will see that the report has a layer called Shipping.

If you hide the layers above this layer (so it only shows the Base and Shipping layers), you will see that:

- Graphics that need to be shipped nationally are shown in the color of the National label (purple in the example below).

- Graphics that need to be shipped internationally are shown in the color of the International label (green in the example below, cut paths are shown in red).
Example 2: Using Custom Fields as Grouping Keys

You need to print different graphics on the same substrate, but some will need to be laminated and some not.

1. In the Configure tool, define a Custom Field as Lamination, and select Use as grouping key.
   
   The corresponding Custom Field parameter in this task tab will now be called Lamination instead.

2. When launching the task on graphics to be laminated, enter Yes in that parameter, otherwise enter No.

3. The nesting server will generate layouts with either:
   
   - only graphics to be laminated,
   - only graphics that shouldn't be laminated.
Note: If you generate a layout report, it will have the label **Yes** if the graphics on that layout need to be laminated, **No** if they don’t.

## 5.4 Export Nested Layouts

Use this task to create production files (a PDF print file and a cutting file) from your nested Gang Run Printing layouts.

Typically, the **Export Nested Layouts** task is the main part of your Gang Run Printing **output workflow**.

When working with Gang Run Printing:

1. You submit the graphics to be nested and printed through the **input workflow**.
2. The **nesting server** automatically nests the graphics on the substrate, and sends the resulting nested layouts to the output workflow **linked to the substrate queue**.
3. The **output workflow** generates production files from the nested layouts.

Note:

In a workflow, this task has five output pins (**Print Files**, **Cutting Files**, **Done Graphics**, **Input** and **Error**), so you can send each type of file to the right place more easily.

If you select **Create report**, the task will have an extra output pin for the report.

Read more in:
- **Sheet Tab** on page 41
- **Production Files Tab** on page 45
- **Reports Tab** on page 47

### 5.4.1 Sheet Tab

1. If desired, you can add **SmartMarks** (a SmartMarks set that you created in i-cut Layout or PackEdge) to your sheet.

   For example, you can use a SmartMarks set containing registration and/or cut marks. You can use SmartNames to enter your SmartMarks set’s name.

Note:

Before you can do this, you need to:

1. Make sure your icut Layout or PackEdge application is connected to your Automation Engine server.
2. Create and save a SmartMarks set in icut Layout or PackEdge (this automatically saves it to the correct location on your Automation Engine server: `\\AEservername\bg_data_marks_v010\dat`).

See the icut Layout or PackEdge manual for more information about connecting to an Automation Engine server and creating a SmartMarks set.
2. When the *nesting server* generates your nested layout, it places the layout on the sheet based on the settings of the substrate queue you chose (*sheet size and margins* and *nesting settings*). However, you may want to move the nested layout on the sheet for printing and finishing purposes. In *Center Layout on Sheet* you can choose to center the layout either *Vertically*, *Horizontally*, or *Vertically and Horizontally*.

In the example below, the nested layout has been centered both vertically and horizontally.

3. If you are working with substrate rolls or large sheets, you can choose to fit the final PDF that will be printed (the "sheet" file containing your nested layout) to one or both of the layout's dimensions. This way, you can cut closer to the layout and have less substrate waste (for rolls) or save the remaining blank area as an offcut so you can reuse it (for large sheets).

For *Fit Sheet*, choose either:

- *To Layout Height* to fit the sheet height to the height of your nested layout.
- **To Layout Width** to fit the sheet width to the width of your nested layout.

- **To Layout Width & Height** to fit the sheet height and width to the height and width of your nested layout.
4. If you are printing Front and Back, define how the sheet will be turned for back printing in **Backing Up**: either **Work-and-Turn** or **Work-and-Tumble**.

This influences how the back graphics will be placed in your final PDF.

Front (at left) and back (at right) with **Work-and-Turn**:

Front and back with **Work-and-Tumble**:
5.4.2 Production Files Tab

The task will output:

- PDF print files,
- cutting files (in your desired format).

**Note:** You will always have a single page PDF print file per layout, unless you are printing front and back (in this case, the back graphic(s) will be on a second page).

1. In **Save Cutting Files**, choose the cutting file format you want to generate (i-cut, HPGL, PDF, MFG, ACM or JDF).

**Tip:**

- If you have several cutting tables and you don’t know yet which one you will use to cut the sheet, you can generate several file formats: choose **Select File Types...**, select all the file types you want to generate and click **OK**.

- If you want to check your cutting files for quality control, you can also output a PDF file and inspect it in Acrobat.

When generating an **ACM** file (for a Kongsberg table), you can select **Print Side Up** to cut with the print side visible.

For all cutting file types except **JDF**, you can influence the knife or cutting head’s cutting sequence:

- Leave **Sequence lines** deselected if you want to use the original cut paths for the cutting lines (this way, common lines between graphics are only cut once, but every graphic is still cut individually).
• Select **Sequence lines** if you want the vertical and horizontal cutting lines to be concatenated so that the knife can cut longer lines at once (so the knife doesn’t need to be lifted and brought down, and accelerate and decelerate, as often, which speeds up the cutting process).

If you have selected **Sequence lines**, you can choose to **Cut Across Gaps** to cut longer lines at once even if there is a **gutter** between your graphics.

---

**Attention:**

If you are generating an **i-cut** file, make sure you have **i-cut marks** in your file as they are needed to define where to start cutting.

Other SmartMarks in your file will not be used for that purpose when working with an i-cut file.

For more information about i-cut marks, please see the i-cut Layout manual.

---

2. By default, all inks with the **technical** ink type (including the ink used for the cut path) are considered structural inks, and are included in the cutting file but not in the print file.

If you want to include other inks from your graphic in the cutting file but not in the print file, enter their names in **Add Extra Structural Inks**.

When adding several inks, you should separate the ink names with a comma (for example Crease, Kiss-cut). You can also use wildcards (*) and SmartNames.

3. By default, the output files have an automatically generated name containing unique identifiers (for example nestingXXXX/YYYYYYY.cut and nestingXXXX/YYYYYYY.pdf).
Note: If multiple copies of the same layout need to be printed, the number of copies will be part of the PDF file name.

If you want to give your output files a specific name, enter it in Output Name.

Attention:
Make sure you include a unique identifier in the name so that your output files do not overwrite each other! This can happen for example if several layouts are generated.
To prevent this, we recommend you include a SmartName such as Task ID.

4. Define where to save the production files and the report(s):
   • If you want to save all output files in the same folder, select Save all files in the same folder, and browse to that Output Folder.
   • Otherwise, make sure Save all files in the same folder isn’t selected, and browse to your chosen folder for the Print Files, Cutting Files and Report Files.

5.4.3 Reports Tab

You can create one or more nesting reports if desired.
   • If you want XML reports (typically used as feedback for an MIS system):
     • Select Create report per graphic if you want a report for each graphic nested (detailing on which layout and substrate it is nested).
     • Select Create layout XML report if you want a report detailing the different graphics used in each layout.
     • If you want a PDF report detailing the different graphics used in each layout, select Create layout PDF report.
       This is typically used as instructions for the cutting table operator.
       You can select:
       • the Report Size (A4 or Letter),
       • the Resolution used for graphics in the report (in the unit defined in the Pilot Preferences),
       • the Units used in the report (mm or inch).